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ABSTRAK

Setelah menganalisa permasalahan proses pengisian colocation application form pada
departemen asset assessment, penulis menemukan sering terjadinya perbedaan pada penggunaan
istilah,sering hilangnya dokumen formulir cetak dan organisasi data yang tidak baik. Sebagai pemecahan
masalah dilakukan perancangan system informasi colocation application untuk pemasangan peralatan
base transceiverstation menggunakan metodologi System Development life cycle dengan metode
pendekatan terstruktur. Sistem vyang diusulkan dalam pembuatannya menggunakan bahasa
pemrograman PHP dan database MySQL, yang disajikan dalam bentuk berbasis web. Dengan tujuan
untuk menghasilkan efisiensidan organisasi data yang baik, sehingga masalah yang timbul dapat
diminimalisir. Serta menjadikan efektifitas yang lebih baik dalam bekerja untuk para penggunanya.

Kata Kunci:Sistem informasi, colocation application.

1. PENDAHULUAN
Infrastruktur telekomunikasi merupakan
salah satu penopang keberhasilan suatu negara,

pertumbuhan yang besar di Indonesia, seiring
pertumbuhan yang cepat menyebabkan
pertumbuhan permintaan informasi juga

pada negara-negara maju di dunia. Dalam
laporan tahunan negara yang tercatat dalam
nota keuangan Republik Indonesia 2010, sector
telekomunikasi, pada 2009, menempati urutan
pertama sebagai sektor yang mengalami
pertumbuhan  signifikan, dengan angka
pertumbuhannya mencapai 13,6%. Hal ini tak
lepas dari peran sector telekomunikasi dalam
membantu proses pertumbuhan ekonomi di
Indonesia (sumber :ekonomi.kompasiana.com,
2010).

Bisnis penyedia sarana infrastruktur
telekomunikasi khususnya menara
telekomunikasi merupakan bisnis yang masih
punya peluang besar untuk berkembang di
indonesia, karena tingkat penetrasi yang masih
relatif rendah dibandingkan dengan negara-
negara tetangga indonesia. PT. Tower Bersama
Infrastruktur, Tbk  dengan inti bisnis
menyewakan sarana telekomunikasi berhasil
menjadi salah satu perusahaan terbesar pada
sektor penyedia menara telekomunikasi dengan

menjadi beragam, menuntut pengelolaan data
yang baik agar efisien dan hemat waktu.

Pengelolaan data untuk menghasilkan
informasi yang akurat dan cepat adalah salah
satu hal wajib pada PT. Tower Bersama
Infrastruktur, Tbk, khususnya departemen asset
assessment karena permintaan colocation yang
dating dari pelanggan melalui account manager
setiap harinya cukup banyak. Karena proses
yang menuntut diselesaikan dengan cepat
menjadikan sering lalainya account manager
ataupun staf asset assessment pada proses
pengisian form colocation application dan
keterlambatan staf asset merespon permintaan
informasi perhitungan dasar seperti sisa lahan
pada tower menyebabkan proses collocation
menjadi terhambat. Tujuan untuk menganalisa
dan merancang sebuah sistem yang diharapkan
dapat mempermudah proses pengisian formulir
colocation application dan pengelolaan data
asset.

51



Jurnal Teknologi Informasi Vol. 1, No. 1, Desember 2015 ISSN : 1693-3672

2. Metode Penelitian Tabel 1 Spesifikasi Perangkat keras komputer
2.1. Observasi,wawancara,dan pustaka AMD(DUAL CORE)
2.2. Metodologi System Development Life PMrzf:Zf;r ;'1620 ;HBZRAM

Cycle dengan metode pendekatan .
e i . Hardisk 80 GB
terstruktur memiliki fase-fasemeliputi :

2.4.1. Perencanaan Sistem Menitor Lenovo 11.6"

Di dalam fase ini mendefinisikan tujuan VGA Card Intel Graphic 256 Mb
dan ruang lingkup  pengembangan, Mouse Standar
kemudian dilanjutkan dengan Keyboard Standar
mengidentifikasi masalah, serta
menentukan strategi dan teknologi yang
akan digunakan dalam pengembangan Tabel 2. Spesifikasi perangkat lunak komputer
sistem. Operating System \L,J\Il'ic?th“: 7
2.4.2.Analisis Sistem XAMPP for
1) Perancangan Sistem Webserver Local WINDOWS V.
Melakukan analisis data, membuat BahasaPemrograman :»5535.3.1
skema database, dan merancang user
) Database MySQL 5.1.4.1
interface.
2) Implementasi Sistem Web Browser ZM;Si"aFirEfox
Membuataplikasiberdasarkandesainsist
em, mengevaluasi, 3.2.Implementasi
danmemperbaikiaplikasi.
3) Pemeliharaan Sistem 3.2.1.Tampilan login
Menjagasistem, agar Tampilan pertama kali yang dapat dilihat
tetapmampuberoperasisecarabenarmel oleh wuser adalah halaman login dari
aluikemampuansistemdalammengadapt aplikasi sisteminformasicolocation
asikandirisesuaidengankebutuhan. applicationuntuk pemasangan peralatan
base transceiver station, user diharuskan
3.HASIL memasukan username dan password yang
tentunya sudah terdaftar atau didaftarkan
3.1.Implementasi Sistem oleh seorang administrator untuk dapat
melanjutkan masuk kedalam aplikasi ini.
3.1.2.Spesifikasi Perangkat Kerasyang Tampilan halaman login seperti terlihat
Diusulkan pada gambar berikut :
e 1 . | =
"’ R ———
~\/_ TOWER A (& A

A N B

SICAF LOGIN FORM

3
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X

&

o

El Wi =Tl.enlk]

Gambar 1 Tampilan halaman login

Setelah user memasukan username dan password dengan benar, maka user akan menuju halaman
home yang berisi ucapan selamat datang juga menu yang dapat diakses melalui list tautan
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disebelah kiri halaman tersebut. Tampilan halaman home tersebut dapat dilihat pada gambar 2
berikut :

€ @ localhost/sicafku/media.php?module=home @ [~ singkatan atau anonim PE A 8- ®

8 Most Visited || PHP-MySQL | | Iphone-Gadget | Codelgniter' | | Download OK || Tutorial Umum-Bagus | | Berita Daerah | PHP-Form-Jquery | | Kuliah Reff (3| agan yg berkiprah di d... || Kaskus - Home Login »

N\ TowEr
o, J BERSAMA

/N croup

» Home

Loggin Succes

» Manajemen User

» Antenna DB Hai Admin Kece, selamat datang di SICAF OnLine (Sistem Informasi Colocation Application Online).
» Site Info Silahkan klik menu pilihan yang berada di sebelah kiri untuk mengelola content Program Dasar ini.

» Laporan (Summary)
» ColoApps.
» DWG

» Logout

Rabu18 Desember 2013
05:58:53 WIB

Copyright © 2013 by Al rights reserved.

ss9AM |

12/18/2013

Gambar 2 Tampilan halaman Home
Tampilan halaman manajemen user
Tampilan halaman manajemen user, merupakan salah satu menu yang berfungsi menampilkan

informasi user berdasarkan username dan password yang digunakan pada saat /ogin. Tampilan
halaman tersebut dapat dilihat pada gambar 3 berikut :

€ | @ localhost/sicafku/media.php?module=user @ - singkatan atau anonim P E A R e
8 Most Visited | | PHP-MySQL | | Iphone-Gadget | | Codelgniter' || Download OK | | Tutorial Umum-Bagus | | Berita Daerah || PHP-Form-Jquery || Kulish Reff || agan yg berkiprah di d... [/ Kaskus - Home Login »
N\ TOWER oy &
o~ BERSAMA p Tf
J\ croup S
g %
A .
» Home
User [Edit] ‘
» Manajemen User
o NIK USERNAME | NAMA LENGKAP EMAIL NOTELP/HP | JABATAN | BLOKIR | AKSI
» Antenna DB
1| 201312160002 | admin Admin Kece | edninteceqamaiiom 02175777772 |userBasa | N |edt
» Site Info : : |
» Laporan (Summary) Tambah User
» ColoApps
»DWG
» Logout
Rabu18 Desember 2013
06:06:34 WIB

606AM |
127182013

Copyright © 2013by Allrights reserved.

S A =
Gambar 3 Tampilan halaman manajemen user
a. Tampilan halaman submenu edit dari halaman manajemen user
Halaman manajemen user memiliki submenu edit yang berfungsi untuk melakukan update atau

editing informasi detail dari user berdasarkan login username dan password. Tampilan halaman
submenu edit manajemen user dapat dilihat pada gambar 4 berikut ini.
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€ | @ localhost/sicafku/media.php?module:

18 Most Visited | ) PHP-MySQL | | Iphone-Gadget | Codelgniter'

ct=edituserBiid=aTbbveljlsp34

ISSN : 1693-3672

N\ Tower
o, \ BERSAMA

J\ croup

» Home

» Manajemen User

» Antenna DB

» Site Info

» Laporan (Summary)
» ColoApps

»DWG

» Logout

Rabu18 Desember 2013

06:07:15 WIB

Download OK

Tutorial Umum-Bagus

0
%

NIK +[ 201312160002 il
Username + [admin o]
Password )

Nama Lengkap | : Admin Kece

Emai  adminkece@gma.com
No.Telp/HP + 02175777772

Jabatan + |User Biasa

Alamat [ Bandung

) Apabila password tidak diubah, dkosongkan saja.
=) Userame tdak bisa dbah.

Edit User

¢ [B- singkatan atau anonim

Berita Daerah | | PHP-Form-Jquery | | Kuliah Reff (| agan yg berkiprah di d
st

Copyright © 2013 by Allrights reserved.

B A Sl

Gambar 4 Tampilan halaman submenu manajemen user edit

b. Tampilan halaman Antenna Information
Halaman antenna information adalah salah satu menu yang memuat list dari antenna masing-
masing lokasi berurutan berdasarkan site id yang sudah ada aktual dilapangan termasuk nama
akronim dari operator penyewa yang sudah ada, tanggal validasi dan orang yang melakukan validasi
terhadap antena di masing-masing lokasi tersebut, tampilan halaman antenna information seperti
terlihat pada gambar 5 berikut ini :

€ |9 | @ localhost/sicafku/media.php?module=antennas

[2) Most Visited || PHP-MySQL |_| Iphone-Gadget | | Codelgniter’

N\/_ ToWER

o, N BERSAMA

/N croup

» Home

» Manajemen User

» Antenna DB

» Site Info

» Laporan (Summary)
» ColoApps

»DWG

» Logout

Rabu18 Desember 2013
06:12:30 WIB

& | B~ singkatan atau anonim

IR S R

Download OK | | Tutorial Umum-Bagus | | Berita Daerah | | PHP-Form-Jquery | | Kuliah Reff (3] agan yg berkiprah di d... || Kaskus - Home Login

Antenna Info Lihat Semua Data Cari Berdasarkan Site :
EXISTING | EXISTING | EXISTING pIC

No|  SITED SITENAME el Gl LevNe | vamaTe | C Axst
1 | 10028110 Lamreung XL-SMART |12 3 2013-12-16 | Mahfud MD | Edit | Del | View
2 | 110001103 ORAETLABORAPANGPOL | HCPT 3 1 20130607 :2:;3“"‘ Edit | Del | View
3 | 110010109 PULAU TIDUNG BESAR TSEL 6 2 2013-12-15 | AdiRistian | Edit | Del | View
4 | 290021110 Remboken X 6 2 2013-12-16 | AdiRistizn | Edit | Del | View
5 | TBGO3_SSM34 | SIALANG PALEMBANG HCPT 6 2 2013-11-29 | AdiRistian | Edit | Del | View
6 | TBGO4_WIKTO14 | KH. NASIR-SRENGSENG TEL-ML |12 4 2013-12-14 :g:‘;"hf"“ Edit | Del | View
7 | TBGOS_NIKT208 | KOMPLEK IMIGRAST TSEL 6 2 2013-12-12 | Jokowi Edit | Del | View
8 | TBGOSRAUIS | BASERAH FLEXI 3 2 2013-12-13 | AdiRistian | Edit | Del | View
9 | TBGOS_RAU16D | AKAP TERMINAL BUS FLEXI-ISAT | 12 3 2013-12-12 | Ahok Edit | Del | View

Copyright © 2013by Allrights reserved.

Gambar 5 Tampilan halaman Antenna information

c. Tampilan halaman antenna information [edit mode]
Masih di dalam tampilan halaman antenna information, user dapat menuju ke halaman antenna
information [edit mode] untuk melakukan proses edit merubah isi informasi antenna berdsarkan
site id dan operatornya. Tampilan halaman tersebut dapat dilihat pada gambar 6a berikut :

1% 100

. ] Kaskus - Home Login

618AM |

12/18/2013

610AM
12718/2013

Pl A & #|-

»

]
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€ @ localhost/sicafku/ 2 Ract=editA 110010109 | B~ singkatan atau anonim PlLE A 8- ®

12} Most Visited |_| PHP-MySQL | | Iphone-Gadget | Codelgniter' | | Download OK | Tutorial Umum-Bagus | | Berita Daerah | | PHP-Form-Jquery | Kuliah Reff 3| agan yg berkiprah di .. (% Kaskus - Home Login »

N\ Tower
o, X BERSAMA

J\ crour

Xiome ‘ Antenna Information [Edit Mode] ‘
m

» Manajemen User | sem ;| aoowies | stememe ;] PULAU TIDUNG BESAR |
» Antenna DB
SR ‘ No CAF ‘ | 1312007 | Operator E _‘Tsn _"npecnﬁ ‘: n ‘
» Laporan (Summary) NO = QUOTA MODELS HEIGHT | QUANT DIMS FEEDER REMARKS
» ColoApps 1| RF#L | KathrenK742265 256 3 175x0.25%0.33 | 6x 78
»DWG 2 RF22 | KathreinK742265 05 3 175x0.25x0.33 | 6x1-1/4
» Logout

3 | mws1 | wapors E 1 06 217

Test CAF New
4 MW#2 Ericsson 1.2 332 > 8 0.6 2x 14"
s | vwss | Hueneing 28 1 06 2014
MWs4 | NEC Pasolink 0.6 %5 1 06 2x14°
Rabu18 Desember 2013 L
19115

e imi=Tal

Gambar 6a Tampilan halaman antenna information [edit mode]

Masih dalam halaman antenna information [edit mode], jika dalam satu lokasi terdapat lebih dari
satu operator penyewa, maka aplikasi akan menampilkan tabel informasi antenna seperti terlihat
pada gambar 6b berikut :

e S T -

€ | @ localhost/sicafku/media phpimodule=antennasiiact=editAnt G04_WIKTOL4 @ - singkatan atau anonim PAd A B~ @~

8 Most Visited | PHP-MySQL |__ Iphone-Gadget || Codelgniter’ _| Download OK | Tutorial Umum-Bagus || Beita Daerah | | PHP-Form-Jquery || Kulich Reff || agan yg berkiprah di d... | Kaskus - Home Login »

N\/_ TowER
o>, X BERSAMA
N crour % A

» Home

Antenna Information [Edit Mode]
Manajemen User =T T T L
T Steld +| TBGO4_WIKTO14 Site Name : KH. NASIR-SRENGSENG
» Antenna DB = - = z
»Ste Info NoCAF 1| 1312008 Operator i Toe CAF i
» Laporan (Summary) nNO QUOTA MODELS HEIGHT QUANT DIM'S FEEDER REMARKS
» ColoApps 1| REEL | KathvenKra2ss % 3 175%0.25%0.33 | 6x78"
»DWG 2 | RF82 | Katvenk7e22ss 243 3 L75X025%0.33 | 6x1-1/4
» Logout | | I I T T
3| MWs1 | NECPasonk0.6 2s 1 06 218
4| Mws2 | Eriosson1.2 35 1 03 2
5 MW23 | Huawei 0.9 30.2 1 12 x4
6 | Mws 0 0 0
Rabu18 Desember 2013
06:40:11 WIB E
NoCAF : 1312009 Operator ¢ TSEL Tioe CAF n
NO QUOTA MODELS HEIGHT QUANT DIM'S FEEDER REMARKS
1| RFEL | KathvenK7a2265 36 3 175x0.25%0.33 | 6x78"
2 | RFR2 | TDISOITIBITOMESTO 24 3 277%0.26x0.14 | 6x 78"
3| MWs1 | NECPasoknk0.§ 3 1 09 27
4 | MW | Eicssn12 % 1 06 21
s | mwss 0 0 0
6 | Mws4 0 0 0
Rabu18 Desember 2013 : ‘
save | [Reset |
011 B (o) (]

Copy

rldlalal

Gambar 6b Tampilan halaman antenna information [edit mode]
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d. Tampilan halaman Site Info
Halaman Site info adalah halaman yang memuat /ist lokasi berurutan berdasarkan site id dengan
field yang ditampilkan ada 8 kolom mewakili informasi dasar paling diperlukan dari sebuah site atau
lokasi. Halaman ini juga berfungsi sebagai ringkasan informasi dari seuruh lokasi yang dimiliki
perusahaan. Tampilan halaman Site Info seperti terlihat pada gambar 7 berikut ini :

@ Morilla Firefox 2
le "Edit _\View  History. Bookmark 15" Help

- e T (o @ %
i localhost / localhost | i X [ } i ite x XAMPPIJS <[ +]

€ @ localhost/sicafku/media php ~site @ | B~ singkatan atau anonim Py A R ®|
8 Most Visited |_) PHP-MySQL | | Iphone-Gadget | | Codelgniter’ |_| Download OK | | Tutorial Umum-Bagus | | Berita Daerah || PHP-Form-Jquery | | Kuliah Reff =t agan yg berkiprah di d... || Kaskus - Home Login »
N\\/_ TOWER .
o, .~ BERSAMA :
J\ crour ,_
i i
5 -
» Home site Lihat Semua Data | [ New Sites CariNlama Site :
» Manajemen User L
TOWER b
R no|  sonums sITED SITENAME | LONGITUDE | LATITUDE | REGIONAL | PRovInCE | TOWER | g
» Site Info 1 |0302437031 10028110 Lamreung 95.363373 | 5.560050 | SUMBAGUT g::‘f:;:&h 52 Edit | Del
» Laporan (Summay - |
poran ( ry) e
» ColoApps 2 | 2010/PRI/010073 | 110001103 LABORA- 106800423 | 6.247370 | JABODETABEK | DKIJAKARTA |20 Edit | Del
PANGPOL
»DWG -
PULAU TIDUNG
» Logout 3 | 20105020151 | 110010108 faoe 106.499159 | 5.798650 | JABODETABEK | DKIJAKARTA |72 | Edit|Del
4 | 0101341011 220094109 'MANUNGGAL 115.939529 | -3.354810 KALIMANTAN :gl:mﬂ" 2 Edit | Del
| Suawesi
5 | 0302448031 240021110 Remboken 124.861008 | 1.226500 SULAWEST Utara 2 Edit | Del
6 123213 T00023 Kebumen 2 -7.232320 107.234352 | JATENG JawaTengah |42 Edit | Del
Rabu18 Desember 2013 - 1 T - 1 1 -
07:01:49 WB 7 |6mossst 00032 Buleng 7982873 | 114.988739 | BALNUS Bl 62 | Edit|Del
s | TBGO1BLIOD | TALIBENG 115438438 | 8.497330 | BALNUS Bl 2 |Edt|Del
9 |T198249 | TBG0O2_W]200 Medaeng 106.452324 | -6.453233 JATIM Jawa Timur 55 Edit | Del
SIALANG Sumatera
10 | 910028 ‘TEGDLSSMJ% PALEMBANG 104775612 | -2.966750 | SUMBAGSEL | c it 2 Edit | el 3

DWEE™ ey ' ’

Gambar 7 Tampilan halaman Site Info

e. Tampilan halaman Site Information [New]
Tampilan halaman Site Information [New] ini berfungsi untuk melakukan proses menambah site
atau lokasi dengan memasukan informasi pada formulir yang tampil. Tampilan halaman tersebut
dapat dilihat pada gambar8 berikut ini.

@ Moxilla Firefox
File Edit View Higtory Bookmarks Tools Help

2 locabist Jocabost] i =siteBact=Newsite x | [Z]XAMPP 173 ——— P—
€ | @ localhost/sicafku/media.php?module=siteStact=NewSite @ B - singkatan atau anonim PleE A 8§~ &
8 Most Viited || PHP-MySQL | Iphone-Gadget |_| Codelgniter' |_| Download OK || Tutorial Umum-Bagus | | Berita Daerah | | PHP-Form-Jquery || Kuliah Reff || agan yg berkiprah di ... 2] Kaskus - Home Login »
=
N\ ToweR 3 e
o ~ BERSAMA : e g
]\ crour § o
e G
i o

» Home = =
Site Information [New]

» Manajemen User

» Antenna DB SO Numb H Company
Hetenic Sted : Operator D
» Laporan (Summary)
Site Name: H TEnant No
» ColoApps
e Longitude : Tower Type : Tower Height :
» Logout Latitude : SteType
Regional : DWGID
Province
Address
Residence

Rabu18 Desember 2013
simpan | [ Batal
s B (o)

Copyright © 2013by. Alrights reserved,

£ F_._ — M ||
m | @ B35 C ongnm

 Gambar 8 Tampilan halaman Site Information [New]
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f. Tampilan halaman Site Information [Edit]
Tampilan halaman Site Information [Edit] ini berfungsi untuk melakukan proses merubah atau edit
informasi detil dari suatu lokasi yang dipilih berdasarkan site id. Tampilan halaman tersebut
dapat dilihat pada gambar 9 berikut ini.

@ Mozilla Firefox

i .
s localhost / localhost |

€ | @ localhostsicafku/media,php?modul ct=editsiteSlid=10028110 @ B~ singkatan atau anonim P A @ o
8 Most Visited | | PHP-MySQL | | Iphone-Gadget | | Codelgniter' | | Download OK | | Tutorial Umum-Bagus | | Berita Daerah | | PHP-Form-Jquery | | Kuliah Reff || agan yg berkiprah did... [/ Kaskus - Home Login »

N\ TOWER . ;
o, X BERSAMA ;
]\ crour /§ s
A “ ‘

» Home
Site Information [Edit]
» Manajemen User

» Antenna DB SO Number + 0302437031 Company : s
» Site Info Site ID 10028110 OPerator ID P XL
¥lLagofan (Summary) Site Name : Lamreung TEnantNo i1
» ColoApps
Longitude : 95363373 Tower Type 1 SST4
»DWG
SHiogeli Latitude + 5560050 Tower Height 52
Regional + SUMBAGUT Site Type i
Province + Nanggro Aceh Darusalam Residence : ACEHBESAR
Address + 1. Makam T. Nyak Arief Lorong Abu Sufi Kel. Lamreung Meunaszh Papeun Kec. Barona Jaya Kab. Aceh Besar
Rabu18 Desember 2013 |
07:07:40 WIB

Copyright © 2013 by Alrights reserved.

70am [
12/18/2013

Gambar 9 Tampilan halaman Site Information [Edit]

g. Tampilan halaman ColoApps
Halaman Coloapps menampilkan informasi berupa tabel list dari colocation application yang pernah
diinputkan kedalam sistem informasi, tabel tersebut memuat informasi penting mulai dari site id,
site name, jumlah antenna, dan ketinggian antenna sesuai dengan colocation application yang
diinputkan. Tampilan halaman tersebut dapat dilihat pada gambar 10 berikut :

@ Mozita Firetox. Jil oo e

i localhost/ localhost | | x | [E]xampp173 > a v v A . e |
€ | @ localhost/sicafku/media php?module=caf @ B~ singkatan atau anonim Pl A &> @~
8 Most Visted || PHP-MySQL | | Iphone-Gadget | | Codelgniter' | | Download OK |_) Tutorial Umum-Bagus | | Beita Daerah | | PHP-Form-Jquery | | Kuliah Reff || agan yg berkiprah did... | Kaskus - Home Login »
= e
N\ TOWER e 1
-
- I \\ BERSAMA
&
3
ZiHomel ColoApps List Linat Semua Data | [ New Coloapps: Cari :
» Manajemen User
+ fotena 0o wo| emew P T v T —— wost
» Site Info 1 | mozs1m Lanveung s 36137 |4 |50.51447130.2147.5 | Edt|Del|View
» Laporan (Summary) 2 | 1028110 Lanreung SWART | 6 w2 1 7001010 Edit|Del | View
» ColoApps 3 | 110001103 ORAETLABORAPANGPOL | HCPT |3 15310 1 125101010 Et | Del | View E
» DWG 4 | 110010108 PULAU TIDUNG BESAR BTEL |6 256(30.5 |4 33133.220.81265 | Edt | Del | View
» Logout 5 | 240021110 Remboken X 6 60.5(55.5 |2 45068.610]0 Edit | Del | View
6 | TBGD3SSM346 | SIALANG PALEMBANG HOT |6 n714 |3 37.5040.2149.210 | Edit |Del | view
7 | TBG04_WIKTO14 | KH. NASIR-SRENGSENG X 6 50243 |3 225]35]30.20 Edit | Del | View
8 |TBG04.WIKTO14 |KH. NASIR-SRENGSENG TE |6 3361324 |2 37136100 Edit | Del | View
9 | TBGOSNKT208 | KOMPLEK IMIGRAST TH |6 #6190 |3 27.5]32.77]40.55 |0 | Edit | Del | View
Rabu18 Desember 2013 10 | TBGOS_RAU1S9 | BASERAH AEIT |3 .50 2 37.77135510]0 Edit | Del | View
07:16:02 WB |
11 | TBGOS_RAU160 | AKAP TERMINAL BUS FEQ |6 051245 |1 4310[0/0 Edit | Del | View
12 | TBGOS_RAU160 | AKAP TERMINAL BUS 1SAT |6 241227 |2 4313551010 Edit | Del | View

=
722 AM

s

Gambar 10 Tampilan halaman Coloapps
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h. Tampilan halaman Colocation application [New]
Tampilan halaman ini adalah formulir untuk memasukan informasi colocation application baru

sesuai permohonan dari operator calon penyewa. Tampilan halaman informasi ini dapat dilihat
pada gambar 11

@ v T TR T . =@ 5
File Edit_View Histonz® Bookmarks=Tools  Help -~ - -
s localhost / localhost | phphyAdmi {7 http://localhostr.. le= cafBlact=NewCaf X XAMPPIJS x| +]

€ | @ localhost/sicafku/media.php?module=cafiact=NewCaf

wo

2 A

| |[B - singkatan atau anonim

P A R e
2 Most Visited | | PHP-MySQL || Iphone-Gadget | | Codelgniter | | Download OK | | Tutorial Umum-Bagus |_| Berita Daerah | | PHP-Form-Jquery | | Kulizh Reff <] aganyq berkiprah di d... (] Kaskus - Home Login

T
L.

»

»Home - -
Colocation Application [New]
> Manajemen User
4 Antenna DB o CAF : _Date Caf : Longiude :
»Site Info Operator Latitude
> Laporan (Summiary) Tipe CAF Tower Type
> ColoApps
Site ID Tower Height
»DWG
» Logout Site Name RTC
MarketingName | ¢ Reganal
O | QUOTA MODELS HEIGHT | QUANT DiMs FEEDER REMARKS
1] RFe1 F
Rabu18 Desember 2013 2 | RFf2
07:23:34 WIB
3| mwsl
4| mwsz
5 | mw=s
6 | Mwss

Gambar 11 Tampilan halaman Colocation application [New]

i.  Tampilan halaman Colocation application [Edit]
Masih dalam menu Coloapps, berikut dibawah ini adalah tampilan dari halaman Colocation
Application [Edit] yang berfungsi sebagai formulir edit atau ubah informasi dari sebuah colocation
application. Tampilan summary site ini dapat dilihat pada gambar 12 berikut ini :
F—

44 localhost / localhost | phpMyAdmin ... | {"} http://localhost/s...ditCaf&d=1312003 x | [Z] XAMPP1.73 x

1 |RF21 | KathreinK742265 336 3 165x0.25x0.15 | 6x7/8" | TestNew CAF

Rabul8 Desember 2013 2 |RF#2 | TongyuTD}45-1900-1 7 3 165%0.25x0.15 | 6x1-1/4 | TestNewCAF
07:29:29 WIB

3| MW#1 | NECPasolik 0.6 0.5 1 12 2xU4" | TestNew CAF

4 |Mws2 | Ericsson 1.2 47 1 12 2xU4" | TestNew CAF

5 M3 | Huawei09 2.2 1 18 2x14" | TestNew CAF

6 |Mwss | VHPOLLS 475 1 34 2x14" | TestNew CAF

R
€ | @ localhost/sicafku/media.php?module= caf8tact=editCaf &id=1312003 c ~ singkatan atau anonim P Y R - e
[8) Most Visited | | PHP-MySQL | | Iphone-Gadget | | Codelgniter' | | Download OK | | Tutorial Umum-Bagus | | Berita Daerah | | PHP-Form-Jquery | | Kulizh Reff || agan yg berkiprah di d... (<] Kaskus - Home Login »
[ ’ " =
» Home
Colocation Appiication [Edit Mode]
» Manajemen User
» Antenna DB No CAF i| 1312003 DateCaf: 2013-12-10 Longitude: :| 95.363373
» Site Info Operator Hib Latitude + | 5.560050
Laporan (Stanmary) Tipe CAF (N Tower Type i| ssTa
» ColoApps T T T
SiteD :| 10028110 Tower Height :| 52
»DWG - — | il
Sitogalt Site Name :| Lanreung RTC |0
Marketing Name Regional : | sUMBAGUT

NO | QUOTA MODELS HEIGHT | QUANT DIMS FEEDER REMARKS

Gambar 12 Tampilan halaman colocation application [Edit]

j. Tampilan halaman DWG
Halaman ini berfungsi menampilkan tabel list dari site atau lokasi yang memiliki gambar yang sudah
dimasukan kedalam database untuk dapat diambil atau diunduh oleh user yang membutuhkannya.
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gambar yang tersedia memiliki ekstensi file .pdf agar semua user dapat membuka file yang sudah
diunduh, Tampilan halaman DWG ini dapat dilihat pada gambar 13 berikut :

T e

x |[ElxampP17.3

444 localhost / localhost | phpMy,

g . - —
€ @ localhost/sicafku/media.phpmodule=dwg & [ - singkatan atau anonim Pl A R e
[ Most Visited | | PHP-MySQL | Iphone-Gadget | | Codelgniter || Download OK | | Tutorial Umum-Bagus | | Berita Daerah | | PHP-Form-Jquery | | Kuliah Reff %] agan yg berkiprah di d... || Kaskus - Home Login »
2
N\/_ TOwER - g‘
& < BERSAMA 3 ; i
\ &
J\ crour k A
ji: i ¥
|24 o
»ame cotoApon e ——
» Manajemen User
Wo| SITED | SITENAME NAMA FILE suze oprion
» Antenna DB
1 Collo Apps HCPT 31-01-2013 (TBG03_EJ139 TANJUNGSARI-SBY)___.PDF | 1284342 | Upload | Hapus | download
» Site Info B P g
2 Transmittal BAST FP SIS001.pdf 426638 | Upload | Hapus | download
» Laporan (Summary)
3 BINTAROJAYA3STPMW.wmf 238082 | Upload | Hapus | download
» ColoApps
L 4 CV_AIf Abadi scan.pdf 4715466 | Upload | Hapus | donrioad
» DWG
5 | 10028110 | Lamreung login-dengan-session.pdf 197788 | Upload | Hapus | download
» Logout
goul 6 | 120504110 | 3G Belong Raya | Pemrograman Web dengan PHP MySQL.pdf 4308308 | Upload | Hapus | download

Rabu18 Desember 2013
07:30:37 WIB

Copyright © 2013by Allrights reserved.

Gambar 13 Tampilan halaman DWG

k. Tampilan halaman DWG upload

Halaman ini berfungsi sebagai formulir untuk unggah dwg atau gambar dalam bentuk file pdf, yang
akan disimpan pada direktori yang upload pada aplikasi ini. Tampilannya gambar 14 sebagai berikut :

@ Mozilla Firefox

T — - O

@Amlisis Sistem Informasi ~ Diagr...« |, localhost / localhost / dbbarang... * | ("} http://localhos..pload_drawgiid= x munm kode ditempatkan pada... * | 4 Analisis Sstem Informasi - Diagr... | [ httpi//www.goo..58187178,d.bmk - | +

€ @ localhost/sicafku/media

odule=dwg8tact=upload_drawétid=

[8) Most Visited |

PHP-MySQL | | Iphone-Gadget | | Codelgniter’ | | Download OK | | Tutorial Umum-Bagus |
N\/_ TOWER -
o>, JBERSAMA :
J N croup ~ gf
A
> 48
» Home

» Manajemen User
» Antenna DB

» Site Info

» Laporan (Summary)
» ColoApps

» DWG

» Logout

Kamis02 Januari 2014
09:17:35 WIB

Berita Daerah |

Keterangan File:

Nama File:[ Browse_ ] No fle selected.

& | B~ struktur database adalah Pl e A 8- ®

PHP-Form-Jquery | | Kulizh Reff 52| agan yg berkiprah di d... || Kaskus - Home Login »

Highlight All Match Case X

Gambar 14 Tampilan halaman DWG upload

4. Simpulan
Sistem informasi colocation application untuk
pemasangan peralatan base tranceiver station

dapat menjadi salah satu solusi untuk
meminimalisir kesalahan karyawan yang terlibat
dalam proses input formulir colocation

application secara konvensional dan terbukti

mempercepat proses bisnis yang ada, karena
tidak diperlukan proses input data berulang
dengan menggunakan kertas print, database
yang terintegrasi menyebabkan semua yang
terlibat mengacu pada data yang sama, tidak
ada lagi perbedaan data antar personel
karyawan, tanggung jawab yang terbagi sesuai
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porsinya melalui hak akses dan dapat digunakan
dimanapun selama user membawa peralatan
komputer jinjing dan koneksi internet.
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